# Table of Contents

<table>
<thead>
<tr>
<th>SECTION</th>
<th>TITLE</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAFETY PRECAUTIONS</td>
<td>........................................</td>
<td>viii</td>
</tr>
<tr>
<td>CUMMINS POWER GENERATION POWERCOMMAND) SOFTWARE LICENSE AGREEMENT</td>
<td>........................................</td>
<td>x</td>
</tr>
<tr>
<td>Recitals</td>
<td>........................................</td>
<td>x</td>
</tr>
<tr>
<td>License Grant Restrictions</td>
<td>........................................</td>
<td>x</td>
</tr>
<tr>
<td>Markings</td>
<td>........................................</td>
<td>x</td>
</tr>
<tr>
<td>Materials</td>
<td>........................................</td>
<td>x</td>
</tr>
<tr>
<td>Title</td>
<td>........................................</td>
<td>xi</td>
</tr>
<tr>
<td>Licensee Expenses</td>
<td>........................................</td>
<td>xi</td>
</tr>
<tr>
<td>Payment</td>
<td>........................................</td>
<td>xi</td>
</tr>
<tr>
<td>Updates and Maintenance</td>
<td>........................................</td>
<td>xi</td>
</tr>
<tr>
<td>No Modification by Licensee</td>
<td>........................................</td>
<td>xi</td>
</tr>
<tr>
<td>Warranties</td>
<td>........................................</td>
<td>xi</td>
</tr>
<tr>
<td>Warranty Disclaimer</td>
<td>........................................</td>
<td>xi</td>
</tr>
<tr>
<td>Government Licensee</td>
<td>........................................</td>
<td>xii</td>
</tr>
<tr>
<td>Restricted Rights Legend</td>
<td>........................................</td>
<td>xii</td>
</tr>
<tr>
<td>Confidentiality</td>
<td>........................................</td>
<td>xii</td>
</tr>
<tr>
<td>Termination of Agreement</td>
<td>........................................</td>
<td>xii</td>
</tr>
<tr>
<td>Completeness</td>
<td>........................................</td>
<td>xii</td>
</tr>
<tr>
<td>Export Regulations</td>
<td>........................................</td>
<td>xiii</td>
</tr>
<tr>
<td>Governing Law</td>
<td>........................................</td>
<td>xiii</td>
</tr>
<tr>
<td>Attorney’s Fees</td>
<td>........................................</td>
<td>xiii</td>
</tr>
<tr>
<td>Agreement Successors and Assigns</td>
<td>........................................</td>
<td>xiii</td>
</tr>
<tr>
<td>Reprint Permissions</td>
<td>........................................</td>
<td>xiv</td>
</tr>
</tbody>
</table>

1 INTRODUCTION ........................................ 1-1

| Welcome | ........................................ | 1-1 |
| Additional Hardware Needed | ........................................ | 1-2 |
| Software Features | ........................................ | 2-1 |
| Control Pages | ........................................ | 1-2 |
| About This Operator’s Manual | ........................................ | 1-2 |

2 SOFTWARE INSTALLATION ........................................ 2-1

| Introduction | ........................................ | 2-1 |
| Computer Hardware Requirements | ........................................ | 2-1 |
| Computer Software Requirements | ........................................ | 2-1 |
| i.lon100e3 CD / Software Installation | ........................................ | 2-1 |
| PowerCommand iWatch 100 CD Installation | ........................................ | 2-2 |
# Table of Contents

<table>
<thead>
<tr>
<th>SECTION</th>
<th>TITLE</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td><strong>POWERCOMMAND iWATCH 100 INSTALLATION</strong></td>
<td>3-1</td>
</tr>
<tr>
<td></td>
<td>Introduction</td>
<td>3-1</td>
</tr>
<tr>
<td></td>
<td>Mounting and Wiring of the i.LON 100</td>
<td>3-1</td>
</tr>
<tr>
<td></td>
<td>Mounting the Enclosure</td>
<td>3-1</td>
</tr>
<tr>
<td></td>
<td>Wiring Connections</td>
<td>3-1</td>
</tr>
<tr>
<td></td>
<td>The RJ-45 10/100 BaseT Ethernet Port</td>
<td>3-1</td>
</tr>
<tr>
<td></td>
<td>The DB-9 Console Port</td>
<td>3-3</td>
</tr>
<tr>
<td></td>
<td>RS-485 Serial Port</td>
<td>3-3</td>
</tr>
<tr>
<td></td>
<td>Connecting RS-485 to the ModBus</td>
<td>3-3</td>
</tr>
<tr>
<td></td>
<td>The RJ-11 Telephone Line Port</td>
<td>3-5</td>
</tr>
<tr>
<td></td>
<td>High Voltage Mains Power</td>
<td>3-5</td>
</tr>
<tr>
<td></td>
<td>LonWorks Network</td>
<td>3-6</td>
</tr>
<tr>
<td></td>
<td>Wiring Diagrams</td>
<td>3-6</td>
</tr>
<tr>
<td>4</td>
<td><strong>CONNECTING THE i.LON100e3 TO THE NETWORK AND COMMISSIONING THE POWERCOMMAND iWATCH 100</strong></td>
<td>4-1</td>
</tr>
<tr>
<td></td>
<td>Configuring a PowerCommand iWatch 100</td>
<td>4-1</td>
</tr>
<tr>
<td></td>
<td>Creating a Project Folder and Copying the Image</td>
<td>4-1</td>
</tr>
<tr>
<td></td>
<td>Updating Project Settings</td>
<td>4-1</td>
</tr>
<tr>
<td></td>
<td>Loading the i.LON 100 Image</td>
<td>4-4</td>
</tr>
<tr>
<td></td>
<td>Formatting the i.LON 100</td>
<td>4-4</td>
</tr>
<tr>
<td></td>
<td>Setting a Static IP Address on your Computer</td>
<td>4-7</td>
</tr>
<tr>
<td></td>
<td>Ping Test</td>
<td>4-9</td>
</tr>
<tr>
<td></td>
<td>FTP Transfer</td>
<td>4-11</td>
</tr>
<tr>
<td></td>
<td>Creating an Xdriver Remote Network Interface</td>
<td>4-13</td>
</tr>
<tr>
<td></td>
<td>Opening A copy of the Template Databases</td>
<td>4-16</td>
</tr>
<tr>
<td></td>
<td>Commissioning the Devices</td>
<td>4-21</td>
</tr>
<tr>
<td></td>
<td>Set the PowerCommand iWatch 100 IP Address</td>
<td>4-22</td>
</tr>
<tr>
<td></td>
<td>The Customer's Configuration</td>
<td>4-23</td>
</tr>
<tr>
<td></td>
<td>The Service Webpages</td>
<td>4-24</td>
</tr>
<tr>
<td></td>
<td>Dial-up Connection</td>
<td>4-27</td>
</tr>
<tr>
<td>5</td>
<td><strong>POWERCOMMAND iWATCH 100 WEB PAGES</strong></td>
<td>5-1</td>
</tr>
<tr>
<td></td>
<td>Introduction</td>
<td>5-1</td>
</tr>
<tr>
<td></td>
<td>Important PowerCommand iWatch 100 Web Page Information</td>
<td>5-1</td>
</tr>
<tr>
<td></td>
<td>Genset Web Pages</td>
<td>5-3</td>
</tr>
<tr>
<td></td>
<td>Genset AC Data and Engine Data</td>
<td>5-3</td>
</tr>
<tr>
<td></td>
<td>Genset Annunciator Data</td>
<td>5-3</td>
</tr>
<tr>
<td></td>
<td>Digital I/O Web Page</td>
<td>5-3</td>
</tr>
<tr>
<td></td>
<td>ATS Web Pages</td>
<td>5-3</td>
</tr>
<tr>
<td></td>
<td>ATS AC Data</td>
<td>5-3</td>
</tr>
<tr>
<td></td>
<td>ATS Annunciator</td>
<td>5-4</td>
</tr>
</tbody>
</table>
# Table of Contents

<table>
<thead>
<tr>
<th>SECTION</th>
<th>TITLE</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Controls Web Page</strong></td>
<td>5-5</td>
</tr>
<tr>
<td></td>
<td><strong>Alarm Summary Page</strong></td>
<td>5-7</td>
</tr>
<tr>
<td></td>
<td><strong>Alarm History Webpage</strong></td>
<td>5-8</td>
</tr>
<tr>
<td>6</td>
<td><strong>ALARM GENERATION AND NOTIFICATION</strong></td>
<td>6-1</td>
</tr>
<tr>
<td></td>
<td>Introduction</td>
<td>6-1</td>
</tr>
<tr>
<td></td>
<td>Sending Fault Codes and Types Via E-mail</td>
<td>6-1</td>
</tr>
<tr>
<td></td>
<td>Disabling Alarms for Non-Commissioned LonWorks Devices</td>
<td>6-3</td>
</tr>
<tr>
<td></td>
<td>Alarm Acknowledgment</td>
<td>6-4</td>
</tr>
<tr>
<td></td>
<td>Customizing the 16 User Defined Digital Alarms</td>
<td>6-5</td>
</tr>
<tr>
<td></td>
<td>Alarm Notification Via a Dial-up Provider</td>
<td>6-8</td>
</tr>
<tr>
<td></td>
<td>Archiving /Capturing Alarm Log Data</td>
<td>6-9</td>
</tr>
<tr>
<td>7</td>
<td><strong>USER NAMES AND PASSWORDS</strong></td>
<td>7-1</td>
</tr>
<tr>
<td></td>
<td>Adding New Users/Modifying User Permissions</td>
<td>7-1</td>
</tr>
<tr>
<td></td>
<td>Adding a User</td>
<td>7-3</td>
</tr>
<tr>
<td></td>
<td>Deleting a User</td>
<td>7-3</td>
</tr>
<tr>
<td></td>
<td>Assigning Users to a Group</td>
<td>7-3</td>
</tr>
<tr>
<td></td>
<td>Removing Users from a Group</td>
<td>7-4</td>
</tr>
<tr>
<td></td>
<td>Saving the Webparam.dat File</td>
<td>7-4</td>
</tr>
<tr>
<td>APPENDIX A</td>
<td><strong>TROUBLESHOOTING THE NETWORK CONNECTION</strong></td>
<td>A-1</td>
</tr>
<tr>
<td></td>
<td>Setting a Static Address On Your Computer</td>
<td>A-3</td>
</tr>
</tbody>
</table>
## List of Figures

<table>
<thead>
<tr>
<th>FIGURE</th>
<th>TITLE</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-1</td>
<td>The PowerCommand iWatch 100 Monitoring System</td>
<td>1-1</td>
</tr>
<tr>
<td>2-1</td>
<td>Installation Software List</td>
<td>2-1</td>
</tr>
<tr>
<td>2-2</td>
<td>CD Contents</td>
<td>2-3</td>
</tr>
<tr>
<td>3-1</td>
<td>i.LON 100 Server DIN Rail Locking Tab Location</td>
<td>3-1</td>
</tr>
<tr>
<td>3-2</td>
<td>i.LON 100 Server Dimensions</td>
<td>3-2</td>
</tr>
<tr>
<td>3-3</td>
<td>i.LON 100 Server Data, Console, and Telephone Connections</td>
<td>3-2</td>
</tr>
<tr>
<td>3-4</td>
<td>DB-9 Connector Pins</td>
<td>3-3</td>
</tr>
<tr>
<td>3-6</td>
<td>i.LON 100 Server High Voltage Mains Screw Terminals</td>
<td>3-5</td>
</tr>
<tr>
<td>3-7</td>
<td>i.LON 100 Server LonWorks TP/FT-10 Free Topology Twisted Pair Terminals</td>
<td>3-6</td>
</tr>
<tr>
<td>3-8</td>
<td>PowerCommand iWatch 100 With PowerCommand 3100 Control</td>
<td>3-7</td>
</tr>
<tr>
<td>3-9</td>
<td>PowerCommand iWatch 100 With PowerCommand 2100 Control</td>
<td>3-7</td>
</tr>
<tr>
<td>3-10</td>
<td>PowerCommand iWatch 100 With PowerCommand 3200 Control</td>
<td>3-8</td>
</tr>
<tr>
<td>3-11</td>
<td>PowerCommand iWatch 100 With PowerCommand 1.X, 2.X, 3.X Control</td>
<td>3-8</td>
</tr>
<tr>
<td>4-1</td>
<td>Open the XML File</td>
<td>4-2</td>
</tr>
<tr>
<td>4-2</td>
<td>Ready to Edit Config.xml file</td>
<td>4-2</td>
</tr>
<tr>
<td>4-3</td>
<td>New Connection Description</td>
<td>4-5</td>
</tr>
<tr>
<td>4-4</td>
<td>Port Connection</td>
<td>4-5</td>
</tr>
<tr>
<td>4-5</td>
<td>Port Settings</td>
<td>4-5</td>
</tr>
<tr>
<td>4-6</td>
<td>Formatting the i.LON 100</td>
<td>4-6</td>
</tr>
<tr>
<td>4-7</td>
<td>i.LON 100 in the Bootrom Mode after Formatting</td>
<td>4-6</td>
</tr>
<tr>
<td>4-8</td>
<td>Network Connections Properties Window</td>
<td>4-7</td>
</tr>
<tr>
<td>4-9</td>
<td>Local Area Connection Properties Window</td>
<td>4-8</td>
</tr>
<tr>
<td>4-10</td>
<td>Internet Protocol Properties</td>
<td>4-8</td>
</tr>
<tr>
<td>4-11</td>
<td>Command Prompt Window</td>
<td>4-9</td>
</tr>
<tr>
<td>4-12</td>
<td>Pinging a Device on the Subnet</td>
<td>4-10</td>
</tr>
<tr>
<td>4-13</td>
<td>Ping Test Successful</td>
<td>4-10</td>
</tr>
<tr>
<td>4-14</td>
<td>FTP log-in</td>
<td>4-11</td>
</tr>
<tr>
<td>4-15</td>
<td>FTP Site</td>
<td>4-12</td>
</tr>
<tr>
<td>4-16</td>
<td>LonWorks Interface Icon</td>
<td>4-13</td>
</tr>
<tr>
<td>4-17</td>
<td>Lonworks Interfaces</td>
<td>4-14</td>
</tr>
<tr>
<td>4-18</td>
<td>Naming the Network Interface</td>
<td>4-14</td>
</tr>
<tr>
<td>4-19</td>
<td>Network Interface Type</td>
<td>4-14</td>
</tr>
<tr>
<td>4-20</td>
<td>Entering the IP Address</td>
<td>4-15</td>
</tr>
<tr>
<td>4-21</td>
<td>Opening a Template Database</td>
<td>4-16</td>
</tr>
<tr>
<td>4-22</td>
<td>Renaming Your Network</td>
<td>4-17</td>
</tr>
<tr>
<td>4-23</td>
<td>Network Attached Not Selected</td>
<td>4-17</td>
</tr>
<tr>
<td>4-24</td>
<td>Domain Definition</td>
<td>4-17</td>
</tr>
</tbody>
</table>
# List of Figures

<table>
<thead>
<tr>
<th>FIGURE</th>
<th>TITLE</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>4-25</td>
<td>Connecting to the Network Interface</td>
<td>4-18</td>
</tr>
<tr>
<td>4-26</td>
<td>Network Interface</td>
<td>4-19</td>
</tr>
<tr>
<td>4-27</td>
<td>Network Interface Upgrade</td>
<td>4-19</td>
</tr>
<tr>
<td>4-28</td>
<td>Selecting Onnet</td>
<td>4-20</td>
</tr>
<tr>
<td>4-29</td>
<td>Network Interface Changes from Yellow to Green</td>
<td>4-20</td>
</tr>
<tr>
<td>4-30</td>
<td>Commissioning the i.LON 100</td>
<td>4-21</td>
</tr>
<tr>
<td>4-31</td>
<td>Selecting Online for State</td>
<td>4-21</td>
</tr>
<tr>
<td>4-32</td>
<td>Selection of Device Identification</td>
<td>4-22</td>
</tr>
<tr>
<td>4-33</td>
<td>Service Option for Customer Configuration Requirements</td>
<td>4-23</td>
</tr>
<tr>
<td>4-34</td>
<td>LAN/WAN Network Setup</td>
<td>4-24</td>
</tr>
<tr>
<td>4-35</td>
<td>E-mail Default Option</td>
<td>4-25</td>
</tr>
<tr>
<td>4-36</td>
<td>E-mail and LAN Test Connections</td>
<td>4-26</td>
</tr>
<tr>
<td>4-37</td>
<td>Username and Password</td>
<td>4-27</td>
</tr>
<tr>
<td>4-38</td>
<td>Modem Setup</td>
<td>4-28</td>
</tr>
<tr>
<td>5-1</td>
<td>Selecting Units of Measurement</td>
<td>5-1</td>
</tr>
<tr>
<td>5-2</td>
<td>Webpage Access</td>
<td>5-2</td>
</tr>
<tr>
<td>5-3</td>
<td>Oneline Diagram Web Page</td>
<td>5-2</td>
</tr>
<tr>
<td>5-4</td>
<td>Genset AC and Engine Data Page</td>
<td>5-3</td>
</tr>
<tr>
<td>5-5</td>
<td>Genset Annunciator Data Web Page</td>
<td>5-3</td>
</tr>
<tr>
<td>5-6</td>
<td>Digital I/O Web Page</td>
<td>5-3</td>
</tr>
<tr>
<td>5-7</td>
<td>ATS Source and Load Data</td>
<td>5-4</td>
</tr>
<tr>
<td>5-8</td>
<td>ATS Annunciator Page</td>
<td>5-4</td>
</tr>
<tr>
<td>5-9</td>
<td>Controls Web Page</td>
<td>5-5</td>
</tr>
<tr>
<td>5-10</td>
<td>Relay Outputs</td>
<td>5-6</td>
</tr>
<tr>
<td>5-11</td>
<td>Alarm Summary</td>
<td>5-7</td>
</tr>
<tr>
<td>5-12</td>
<td>Alarm History</td>
<td>5-8</td>
</tr>
<tr>
<td>6-1</td>
<td>PowerCommand iWatch 100 Web Page</td>
<td>6-1</td>
</tr>
<tr>
<td>6-2</td>
<td>Selecting E-mail from Main Menu</td>
<td>6-2</td>
</tr>
<tr>
<td>6-3</td>
<td>Enter Destination E-mail Address</td>
<td>6-2</td>
</tr>
<tr>
<td>6-4</td>
<td>Selecting Service Button ROM Web Page</td>
<td>6-3</td>
</tr>
<tr>
<td>6-5</td>
<td>Alarm Notifier Dialog Box</td>
<td>6-4</td>
</tr>
<tr>
<td>6-6</td>
<td>Alarm Notifier Log Data Points</td>
<td>6-5</td>
</tr>
<tr>
<td>6-7</td>
<td>16 Digital Alarm Points</td>
<td>6-5</td>
</tr>
<tr>
<td>6-8</td>
<td>Data Point Selection</td>
<td>6-6</td>
</tr>
<tr>
<td>6-9</td>
<td>Available Alarms</td>
<td>6-6</td>
</tr>
<tr>
<td>6-10</td>
<td>Scroll Down the Tree</td>
<td>6-7</td>
</tr>
<tr>
<td>6-11</td>
<td>New Connection</td>
<td>6-8</td>
</tr>
<tr>
<td>6-12</td>
<td>New SMTP server</td>
<td>6-8</td>
</tr>
<tr>
<td>6-13</td>
<td>Service Provider</td>
<td>6-9</td>
</tr>
</tbody>
</table>
## List of Figures

<table>
<thead>
<tr>
<th>FIGURE</th>
<th>TITLE</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>7-1</td>
<td>Web Server Security and Parameters</td>
<td>7-2</td>
</tr>
<tr>
<td>7-2</td>
<td>Open Webparams File</td>
<td>7-2</td>
</tr>
<tr>
<td>7-3</td>
<td>User’s Tab</td>
<td>7-3</td>
</tr>
<tr>
<td>A-1</td>
<td>Command Prompt</td>
<td>A-1</td>
</tr>
<tr>
<td>A-2</td>
<td>Entering the Ipconfig Command</td>
<td>A-2</td>
</tr>
<tr>
<td>A-3</td>
<td>Pinging the Powercommand iWatch 100</td>
<td>A-2</td>
</tr>
<tr>
<td>A-4</td>
<td>Ping Failure Message</td>
<td>A-2</td>
</tr>
<tr>
<td>A-6</td>
<td>Selecting “View Network Connections”</td>
<td>A-3</td>
</tr>
<tr>
<td>A-7</td>
<td>Local Area Network Connection</td>
<td>A-4</td>
</tr>
<tr>
<td>A-8</td>
<td>Local Area Connection Properties</td>
<td>A-4</td>
</tr>
<tr>
<td>A-10</td>
<td>Modified Internet Protocol (TCP/IP) Properties</td>
<td>A-5</td>
</tr>
</tbody>
</table>
## List of Tables

<table>
<thead>
<tr>
<th>TABLE</th>
<th>TITLE</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>3-1</td>
<td>i.LON 100 Server DB-9 Pin Assignment</td>
<td>3-3</td>
</tr>
<tr>
<td>3-2</td>
<td>i.LON 100 RS-485 Pin Assignment</td>
<td>3-3</td>
</tr>
<tr>
<td>3-3</td>
<td>i.LON 100 RS-485 Pin Assignment</td>
<td>3-3</td>
</tr>
<tr>
<td>3-4</td>
<td>TB2 Connections for RS-485 ModBus Communications</td>
<td>3-4</td>
</tr>
<tr>
<td>3-5</td>
<td>i.LON 100 Server AC Power Mains Connections</td>
<td>3-6</td>
</tr>
<tr>
<td>3-6</td>
<td>i.LON 100 Server LonWorks TP/FT-10 Network Connections</td>
<td>3-6</td>
</tr>
</tbody>
</table>
Safety Precautions

The PowerCommand Network can be used to remotely operate power transfer equipment (e.g., transfer switches, paralleling systems) and start and stop generator sets. All of the safety precautions for that equipment must be observed. Refer to the Operator’s Manual for the equipment that is being monitored and controlled by the network for important safety precautions.

The following symbols, found throughout this manual, alert you to potentially dangerous conditions to the operator, service personnel, or the equipment.

⚠️ DANGER ⚠️ This symbol warns of immediate hazards which will result in severe personal injury or death.

⚠️ WARNING ⚠️ This symbol refers to a hazard or unsafe practice which can result in severe personal injury or death.

⚠️ CAUTION ⚠️ This symbol refers to a hazard or unsafe practice which can result in personal injury or product or property damage.

MOVING PARTS CAN CAUSE SEVERE PERSONAL INJURY OR DEATH

- Keep your hands, clothing, and jewelry away from moving parts.
- Before starting work on the generator set, disconnect battery charger from its AC source, then disconnect starting batteries, negative (-) cable first. This will prevent accidental starting.

- Make sure that fasteners on the generator set are secure. Tighten supports and clamps, keep guards in position over fans, drive belts, etc.
- Do not wear loose clothing or jewelry in the vicinity of moving parts, or while working on electrical equipment. Loose clothing and jewelry can become caught in moving parts. Jewelry can short out electrical contacts and cause shock or burning.
- If adjustment must be made while the unit is running, use extreme caution around hot manifolds, moving parts, etc.

ELECTRICAL SHOCK CAN CAUSE SEVERE PERSONAL INJURY OR DEATH

- Remove electric power before removing protective shields or touching electrical equipment. Use rubber insulative mats placed on dry wood platforms over floors that are metal or concrete when around electrical equipment. Do not wear damp clothing (particularly wet shoes) or allow skin surface to be damp when handling electrical equipment.
- Use extreme caution when working on electrical components. High voltages can cause injury or death. DO NOT tamper with interlocks.
- Follow all applicable state and local electrical codes. Have all electrical installations performed by a qualified licensed electrician. Tag and lock open switches to avoid accidental closure.
- Jewelry is a good conductor of electricity and should be removed before working on electrical equipment.
MEDIUM VOLTAGE GENERATOR SETS  
(601V to 15kV)

- Medium voltage acts differently than low voltage. Special equipment and training is required to work on or around medium voltage equipment. Operation and maintenance must be done only by persons trained and qualified to work on such devices. Improper use or procedures will result in severe personal injury or death.

- Do not work on energized equipment. Unauthorized personnel must not be permitted near energized equipment. Due to the nature of medium voltage electrical equipment, induced voltage can remain even after the equipment is disconnected from the power source. Plan the time for maintenance with authorized personnel so that the equipment can be de-energized and safely grounded.

TRANSFER SWITCHES

- AC and DC voltages in the transfer switch components present serious shock hazards that can result in severe personal injury or death. Read and follow these instructions.

- Keep the transfer switch cabinet closed and locked. Make sure only authorized personnel have cabinet and operational keys.

- Due to the serious shock hazard from medium voltages within the cabinet, all service and adjustments to the transfer switch must be performed only by an electrician or authorized service representative.

- If the cabinet must be opened for any reason:
  1. Move the operation selector switch on the generator set to Stop.
  2. Disconnect battery charger from its AC source. Disconnect the starting batteries of the generator set. (Remove the negative [-] lead first to prevent arcing from igniting explosive battery gas.)
  3. Remove AC power to the automatic transfer switch. If the instructions require otherwise, use extreme caution due to the danger of shock hazard.

GENERAL SAFETY PRECAUTIONS

- The PowerCommand Network allows remote operation of equipment. PowerCommand Software for Windows can remotely start and stop a genset or exercise a transfer switch. Network modules can independently control other network modules and operate other electrical devices such as fans or pumps etc. Make certain that all appropriate personnel are notified before remotely operating equipment and make them aware of any equipment that can be energized automatically.

- Do not work on this equipment when mentally or physically fatigued, or after consuming any alcohol or drug that makes the operation of equipment unsafe.

- Use only the latest physical and logical connection diagrams for installing and maintaining the PowerCommand Network. If changes are made to the physical or logical network connections, make sure the site connection diagrams are updated. Create a new CSV file if the number or type of modules changes or if the bindings change.
CUMMINS POWER GENERATION POWERCOMMAND® SOFTWARE LICENSE AGREEMENT

By breaking the seal on the PowerCommand diskette envelope, you indicate your acceptance of the terms of this Agreement. If you do not accept the terms of this Agreement, you may return within 5 business days of your purchase the entire contents of this kit to the Cummins distributor from which it was purchased for a complete refund.

RECITALS:

WHEREAS, Onan Corporation d/b/a Cummins Power Generation (hereinafter “CPG”) and Licensee desire to establish a relationship pursuant to which Licensee will obtain certain rights from CPG with respect to the Licensed Software, and CPG will provide certain information and updates to Licensee, all for the mutual benefit of CPG and Licensee; THEREFORE, in consideration of the above premise and the mutual covenants contained herein, CPG and Licensee agree as follows:

1. License Grant Restrictions
   a. CPG hereby grants to Licensee a non-exclusive, non-transferable and non-sublicensable license to possess and use one copy of the Licensed Software contained in this package in machine-readable form to monitor and control power generation systems manufactured or sold by CPG. The Licensed Software is specifically licensed for use in a single facility of Licensee for its intended purpose, and it may not be sublicensed, sold, or otherwise distributed. The license for Licensed Software is subject to the following terms and conditions.
   b. Licensee may load each copy of the Licensed Software and the “Security Key” files provided by CPG onto a single computer as required to use the Licensed Software for its intended purpose. Licensee may make a single backup or archival copy of the Licensed Software in machine-readable form, provided that Licensee affixes to the backup or archival copy any copyright and trademark notice, serial number and any other legend of ownership contained on the original disk from which the archival copy was made.
   c. Licensee agrees to use the Licensed Software, and any updates to the Licensed Software, in strict accordance with CPG’s published service practices and/or product warranty guidelines for the sole purpose of monitoring and controlling power generation systems manufactured or sold by CPG.
   d. Licensee acknowledges that CPG may, at its option and at no cost to the Licensee, provide updates to the Licensed Software so that the most current version of the Licensed Software is used to monitor and control power generation systems. CPG may also offer for sale upgrades of the Licensed Software which the Licensee is under no obligation to purchase.
   e. All rights relating to the Licensed Software not specifically granted to Licensee pursuant to this Agreement shall be retained by CPG.
   f. Licensee acknowledges that the Licensed Software may include software that CPG has obtained or licensed from a third party, and Licensee agrees that the terms and conditions of this Agreement shall be applicable to any such third party software. Licensee agrees to abide by any additional or modified terms and conditions with respect to such third party software if reasonably requested in writing by CPG and/or the third party.

2. Markings
   Licensee shall use its best efforts to preserve all copyright, trademark, ownership or other notices, legends or markings on the Licensed Software as originally provided by CPG. In the event the Licensed Software contains any copyright or other message imbedded therein, Licensee shall not modify or remove such embedded message. All copyright, trademark, ownership or other notices, legends or markings on the Licensed Software as originally provided by CPG also shall be clearly displayed on each backup or archival copy of the Licensed Software.

3. Materials
   The PowerCommand Installation Diskettes, Security Key Diskettes, User Manual, and any updates thereto, constitute the entire product referred to herein as the Licensed Software unless otherwise agreed to by the parties.
4. Title
Title and full ownership rights to the Licensed Software and any updates thereto, and all intellectual property rights, including, without limitation, patent, trademark, copyright and trade secret rights therein, shall remain with CPG and/or its subsidiaries. CPG expressly retains all rights that it may have under U.S. or foreign laws or international treaties relating to the Licensed Software, except for those rights expressly granted to Licensee herein.

5. Licensee Expenses
Costs and expenses incurred by Licensee relating to any use of the Licensed Software, or any other costs not specifically agreed upon by the parties in writing, shall be responsibility of Licensee.

6. Payment
The sales price does not include any federal, state, local or other governmental taxes, or other tariffs which may be imposed on the sale, transportation, production, storage, or export of the Licensed Software. Any and all such taxes and costs shall be paid by Licensee and CPG shall have no liability therefor.

7. Updates and Maintenance
a. CPG agrees to provide reasonable free Help Desk support for the current version and the latest prior version of the Licensed Software at hours, and under terms and conditions determined solely by CPG.

b. In the event of an error or defect in the Licensed Software or periodic update thereto, CPG agrees to repair or remedy such errors or effects which CPG deems necessary. Licensee shall, promptly upon discovery thereof, notify CPG, in writing, of any errors or defects in the Licensed Software and/or periodic update thereto. CPG shall use its best efforts to remedy or repair such errors or defects, devoting reasonable resources to such task in view of the particular business situation and customer need.

8. No Modification by Licensee
Licensee agrees not to translate, rearrange, reverse assemble, reverse compile, enhance, adapt, translate, alter, modify or change in any way the Licensed Software, or any update thereto, without the prior written authorization of CPG.

9. Warranties
CPG warrants that the diskettes containing the Licensed Software shall be free from defects in material or workmanship for a period of ninety (90) days from the date of delivery to Licensee. CPG also warrants that the Licensed Software shall be delivered free of any rightful claim of infringement of any copyright, trademark, trade secret or other proprietary right of any third party, provided that prompt notice of, and control over, such claims is provided to CPG by Licensee. In the event of such claim, CPG may, at its sole option, defend the claim, procure for Licensee the continued rights as described herein, modify the Licensed Software so the claim is avoided without reduced functionally, or refund Licensee’s sales price paid. CPG’s option shall be its sole obligation and Licensee’s sole remedy in such event.

10. Warranty Disclaimer
The Licensed Software and any and all updates thereto are licensed “As Is” with the exception of the warranties specifically provided herein. CPG does not claim and does not warrant that the Licensed Software will run error free. WITH THE EXCEPTION OF THE WARRANTIES PROVIDED HEREIN, CPG DISCLAIMS ALL WARRANTIES, EITHER EXPRESSED OR IMPLIED, REGARDING THE LICENSED SOFTWARE, ITS MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR PURPOSE, AND CPG WILL NOT OTHERWISE BE LIABLE FOR INDIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY KIND WHATSOEVER RESULTING FROM LICENSEE’S USE OF THE LICENSED SOFTWARE OR FOR ANY ERROR OR DEFECT IN THE LICENSED SOFTWARE. CPG’S NET LIABILITY TO LICENSEE SHALL NOT EXCEED THE TOTAL AGGREGATE PAYMENTS BY LICENSEE TO CPG WITH RESPECT TO THE LICENSED SOFTWARE.
11. Government Licensee
If Licensee is acquiring the Licensed Software as, or on behalf of, a unit of the United States Government, the following provisions shall be applicable: The Government acknowledges and agrees that the Licensed Software and documentation relating thereto were developed at private expense and no part of the Licensed Software or documentation relating thereto is in the public domain. The Government acknowledges CPG’s representation that the Licensed Software is “Restricted Computer Software” as that item is defined in Clause 52.227-19 of the Department of Federal Acquisition Regulation Supplement (DFARS). The Government agrees that:

(i) If the Licensed Software is supplied to the Department of Defense (DoD), the Licensed Software is classified as “Commercial Computer Software” and the Government is acquiring only “restricted rights” in the Licensed Software and documentation relating thereto as that term is defined in Clause 252.227–7013(c)(1) of the DFARS, and

(ii) If the Licensed Software is supplied to any unit or agency of the United States Government other than the Department of Defense, the Government's rights in the Licensed Software and documentation relating thereto will be defined in Clause 52.227–19(c)(2) of the FAR.

12. Restricted Rights Legend
Use, duplication, or disclosure by the Government is subject to restrictions set forth in subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227–7013.

13. Confidentiality
a. Licensee hereby acknowledges that the Licensed Software and periodic updates thereto contain valuable information belonging to CPG that CPG considers “confidential”. Licensee acknowledges and agrees that the source code, object code and other information respecting the Licensed Software is confidential information of CPG. Consistent with the purpose of this Agreement, Licensee agrees to use its best efforts not to release, disclose or otherwise permit unauthorized access to such confidential information. In addition to any other rights or remedies which may be available to CPG, CPG (without being required to post any bond or other security) shall be entitled to appropriate injunctive relief against Licensee or its agents in the event of any breach of this section. Licensee acknowledges and agrees that any unauthorized use of disclosure will cause irreparable injury to CPG and that money damages may not provide adequate remedy.

b. CPG and Licensee agree to clearly mark written materials as "confidential" if they are to be treated as confidential. Verbal communications that are confidential in nature will be identified as so before, during or immediately after the communication.

c. Licensee will use its best efforts to ensure that all individuals who are provided access to the Licensed Software under this Agreement will observe and perform this nondisclosure covenant.

14. Termination of Agreement
a. CPG may terminate this agreement for cause in the event that Licensee becomes or is declared insolvent or bankrupt.

b. In the event of termination of this Agreement, all rights granted by this Agreement shall revert to CPG. Upon termination of this Agreement, Licensee will deliver to CPG all material furnished by CPG pertaining to the Licensed Software and will also warrant that all copies thereof have been returned to CPG or destroyed.

c. In the event of termination of this Agreement, Licensee and CPG shall remain obligated with respect to the provisions of this Agreement relating to confidentiality of information.

15. Completeness
Licensee and CPG agree that this Agreement constitutes the complete agreement and understanding between the parties relating to Licensed Software and updates thereto. This agreement supersedes all prior agreements, understandings, and negotiations whether written or verbal with respect to the subject matter hereof. This Agreement can only be modified by a written agreement signed by both parties.
16. Export Regulations
Licensee understands that the Export Administration Regulations of the Department of Commerce of the United States may prohibit the export of the Licensed Software to certain countries and agrees to conform to those regulations. Licensee shall indemnify CPG against any liability or loss related to Licensee’s failure to conform to those regulations.

17. Governing Law
This Agreement shall be governed by and construed in accordance with the laws of the State of Indiana, United States of America and NOT the UNCISG. To the extent required in order to comply with the laws and regulations of any country in which Licensed Software is distributed or used, the terms and conditions of this Agreement shall be construed to most nearly effectuate the purposes of the Agreement as set forth herein. If any provision of this Agreement shall be held to be unenforceable, such holding shall not affect the enforceability of any other provision hereof.

18. Attorney’s Fees
In the event of any legal action or other proceeding that is brought about to enforce this Agreement, the prevailing or successful party shall be entitled to recover reasonable attorneys’ fees as well as other costs incurred in that action or proceeding in addition to any compensation to which it may be entitled as a result.

19. Agreement Successors and Assigns
The terms and conditions of this Agreement shall inure to the benefit of and enforceable by CPG and the successors and assigns of CPG’s interest in this agreement and/or CPG’s ownership of the Licensed Software.

© Onan Corporation 2002
Excerpts from the following quick start guides are reprinted with permission of Echelon:

i.LON 100 e3 Internet Server Quick Start Guide

Excerpts from the following manuals reprinted with permission of Echelon:

i.LON 100 e3 Internet Server User’s Guide: Installing, Connecting, and Configuring the i.LON 100;
i.LON 100 e3 Internet Server User’s Guide: Using the i.LON 100 Web Pages to Configure Application and to Monitor and Control Data Points;
i.LON 100 e3 User’s Guide

In addition, screen shots from the i.LON 100 built-in web pages will be reproduced.

Except as expressly permitted, no part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior permission of Fuji Electric Systems. Excerpts from the i.LON documentation may not be reproduced, stored or transmitted without the prior permission of Echelon Corporation.

Echelon and i.LON are trademarks of Echelon Corporation registered in the United States and other countries.
1. Introduction

**WELCOME**

The PowerCommand iWatch™ 100 is an Echelon™ iLON100e3 based device that provides monitoring and control of generators and/or transfer switches via the Cummins® PowerCommand® FT-10 (Echelon LonWorks®) network. Access to the PowerCommand iWatch 100 can be obtained over an ethernet LAN/WAN, Analog Modem Dial-in or GSM Connection by using Internet Explorer® 6.0 or higher as the GUI.

The PowerCommand iWatch 100 is comprised of three major components:

- **i.LON100e3 Software** – Used to set up the i.LON100 as a Remote Network Interface, add configuration Plug-Ins, and install software upgrades for LonMaker for Windows

- **PowerCommand iWatch 100 Support CD** – Includes the factory image files for LonWork’s gensets and ModBus gensets, network databases, type/format files, security profiles and documentation needed for the PowerCommand iWatch 100 application

- **i.LON100e3 Hardware** – The PowerCommand iWatch 100 works with LonWorks FT-10 network Automatic Transfer Switches (ATSs), genset controls, and 13xx series control (ModBus).
ADDITIONAL HARDWARE NEEDED

The installer must supply the following items; they are needed for installation and application of the PowerCommand iWatch 100.

- DB9 female connector – Female null modem cable (EIA-232)
- Ethernet patch cable (RJ-45 connectors)
- Power cord (type is dependent upon the power supply, 90–230 VAC, 50–60 Hz)

SOFTWARE FEATURES

The features available through the PowerCommand iWatch 100 are briefly described here and are covered in more detail in the section related to that feature.

OneLine Page – Gives an overview of the status of the network and provides links to each of the devices on the network.

Generator Summary – Web page for monitoring generator AC and engine data.

Generator Annunciator – Web page for monitoring all of the generator annunciated alarms.

ATS Summary – Web page for monitoring the ATS source and load data.

ATS Annunciator – Web page for monitoring all of the ATS annunciated alarms.

Alarm History Log – Contains a list of the last 50 alarms.

Alarm Summary Page – Contains a summary of all of the alarms and allows for clearing and acknowledging alarms.

E-mail Page – Contains preconfigured e-mails. You can configure more emails and the recipients.


Control Pages

Genset & ATS – Web page for activating the generator Start/Stop command and Fault Reset buttons as well as Test and Fault Reset for the transfer switches.

Control – Web page for activating the relay outputs.

ABOUT THIS OPERATOR’S MANUAL

This Operator’s Manual covers software installation, setup, and operation of the PowerCommand iWatch 100 application.

- Section 1 provides an overview of this manual and some basic features.
- Section 2 describes the required software to be installed on the service technician’s computer.
- Section 3 covers installation requirements and how to mount, wire, and connect the PowerCommand iWatch 100 to a LAN/WAN or Dial-up ISP modem.
- Section 4 describes how to create the PowerCommand iWatch 100 project folders, modify customer specific settings, and load the web page files onto the iLon100. It also includes setting up hyper terminal, setting up a remote network interface, setting a static IP address on the service computer, configuring a dial-up connection, and commissioning the PowerCommand iWatch 100 using LonMaker® for Windows®.
- Section 5 provides descriptions of the PowerCommand iWatch 100’s user web pages.
- Section 6 provides information on alarm generation and notification, including e-mail configuration.
- Section 7 provides information on setting up different user names and passwords.
- Appendix A provides general information on troubleshooting the network connection.
2. Software Installation

INTRODUCTION

This section covers the installation process and setup instructions for the i.LON100e3 software and the PowerCommand iWatch™ 100 application files. This information is to be used by the technician when creating the network. The end user only needs to make sure that the monitoring computer has access to Internet Explorer 6.0 or higher and the necessary hardware to support this browser.

Unless a new version of the PowerCommand iWatch 100 or new version of i.LON 100 is released, the software described in this section only needs to be installed once on the technician's computer. In order for the complete PowerCommand iWatch 100 application to function correctly, it is necessary to complete all of the setup procedures, as described in each of the sections.

COMPUTER HARDWARE REQUIREMENTS

To use i.LON100 installation and configuration software, your computer must meet or exceed the following hardware requirements.

- Pentium II 600 MHz or faster
- 128 MB RAM minimum
- 70 MB free hard disk space
- CD-ROM drive
- Super VGA (800 x 600) or higher resolution display with 256 colors (1024 x 768 recommended for viewing web pages)
- Mouse or compatible pointing device
- Serial port
- Ethernet RJ 45 port (NIC port)

COMPUTER SOFTWARE REQUIREMENTS

To use i.LON100 installation and configuration software, your computer must meet or exceed the following software requirements.

- Microsoft Windows XP or Windows 2000
- LonMaker 3.1, Version 3.13.10 and LNS version 3.08.05 (Service Pack 8)
- Terminal Emulator (for example, Windows Hyper Terminal)

NOTE: Cummins recommended updates for LonMaker are included on the PowerCommand iWatch 100 CD if needed. You can check your LonMaker version by launching LonMaker. At the first dialog box, click on the LonMaker icon in the far upper left, and select “About Echelon LonMaker”. If you have questions about your LonMaker version, contact service.

I.LON100e3 CD / SOFTWARE INSTALLATION

NOTE: The software on the CD provided by Echelon should be i.LON100 version e3.

FIGURE 2-1. INSTALLATION SOFTWARE LIST

NOTE: DO NOT install Echelon LonMaker 3.1, Update 2 (LNS Turbo). This feature is NOT recommended or supported by Cummins, Inc.

This installation only needs to be performed on the technician’s laptop. i.LON100 software is not needed for viewing the web pages.

The i.LON100e3 software installation CD contains the following:
• i.LON100 Configuration Plug-In (Not needed)
• LonMaker 3.1 update 2. (Do not install.)
• LNS Service Pack 8
• i.LON100 User Guides

There are two different methods available for obtaining the i.LON100e3 software.

• Request it from the CPG Software Shelf.

  **NOTE:** If you are obtaining the i.LON100e3 software from the CPG Software Shelf, keep in mind that it may take several days to receive the software.

• Insert the i.LON100e3 CD provided with the PowerCommand iWatch 100 and follow the steps below.

To install the i.LON100e3 software from the CD:

1. Insert the i.LON100e3 software installation CD into your computer. If the program fails to start, navigate to your CD-ROM drive and run setup.exe.

2. Click on **Install Products**.

3. Click on the **i.LON100e3 SR2 Software** only.

4. Follow the instructions in the setup wizard. Be patient. This may take several minutes. (If your LonMaker version is not at least 3.13.10 and LNS version 3.08.05, the installation may prompt you to install the updates necessary to achieve these version levels. It is recommended that you stop and install these updates separately. They are located in the Echelon updates folder on the PowerCommand iWatch 100 CD.)

**POWERCOMMAND iWATCH 100 CD INSTALLATION**

The support CD contains the necessary files to load onto the PowerCommand iWatch 100, a PDF of this manual, and the supplements described below:

• Network support CD
• PowerCommand iWatch 100 format files
• PowerCommand iWatch 100 LonMaker databases for 2100, 3100, and 32xx generator controls
• Documentation on the PowerCommand iWatch 100, FT-10 Devices, FT-10 and ModBus Network Installation, and application supplements
• Read Me file

**NOTE:** The CD contains folders for both the 2100, 3100, 3200 genset control PowerCommand iWatch 100 and the 1301 genset control (ModBus) PowerCommand iWatch 100 (see Figure 2-2).

For a detailed description of each of the files included, please refer to the Readme.doc file on the PowerCommand iWatch 100 CD. The Readme file includes the names, dates, and location of each of the files on the PowerCommand iWatch CD. Information on file placement is also described in detail.
FIGURE 2-2. CD CONTENTS
INTRODUCTION

This section describes the physical installation of the PowerCommand iWatch™ 100 and the physical connections to the i.LON100 server.

MOUNTING AND WIRING OF THE I.LON 100

The information included in this section is taken directly from Echelon’s “i.LON100 e3 User’s Guide.” This section describes the mounting of the i.LON 100, the LonWorks connection, the console connection, the telephone line connection, the ethernet connection, and the power connection.

For additional information on any of the other connections, refer to the Echelon i.LON 100 User’s Guide.

Mounting the Enclosure

WARNING The i.LON 100 Internet Server is intended to be mounted inside of a suitable, safety-agency approved enclosure that is mounted in a restricted access area. High-voltage wiring must be performed only by a qualified service person.

The i.LON 100 Internet Server mounts to a 35mm x 7.5mm or 35mm x 15mm DIN rail located inside of a suitable, safety-agency approved enclosure, and mounted in a restricted access area. All high-voltage wiring must be performed by a qualified service person. The rear of the i.LON 100 server enclosure contains a spring-loaded DIN rail lock, which securely grabs the DIN rail onto which the enclosure is snap mounted (see Figure 3-1). To release the enclosure from the DIN rail, insert a flat head screwdriver into the DIN rail locking tab and gently pull the tab upwards and away from the enclosure.

Wiring Connections

The i.LON 100 Internet Server is provided with two rows of screw terminal wiring connections, an RJ-45 data connection, an RJ-11 telephone connection, and a DB-9 D-connector for connection to a configuration console. The screw terminals are located on the top and bottom edges of the chassis, and are numbered 1 to 12 (ascending from left to right) on the bottom, and from 13 to 28 (ascending from right to left) on the top. Figure 3-3 shows the locations of all i.LON 100 server connectors.

The RJ-45 10/100 BaseT Ethernet Port

The RJ-45 connector must be used with an RJ-45 male connector and a suitable Category 5 or Category 6 data cable connected to a 10BaseT or 100BaseT channel. The i.LON 100 server will automatically adjust to the speed of the data port, and if a 100BaseT network connection is established it illuminates the “100” LED indicator on the front panel. The i.LON 100 server automatically detects whether it is connected to an Ethernet hub or directly to a computer, so there is no need to use a crossover Ethernet cable.
FIGURE 3-2. i.LON 100 SERVER DIMENSIONS

FIGURE 3-3. i.LON 100 SERVER DATA, CONSOLE, AND TELEPHONE CONNECTIONS
The DB-9 Console Port

The i.LON 100 server contains a console application that is accessed using a terminal emulation program, such as Windows HyperTerminal, via the EIA-232 DB-9 console port. This application allows you to set basic parameters such as the IP address, subnet mask, and FTP user name and password. The DB-9 is designed to be used with a DB-9 null-modem crossover cable with female connectors on both ends that connects the i.LON 100 server and an available COM port on a computer running the terminal emulation program. The connector pins on the DB-9 console are aligned as shown in Figure 3-4. The connector pins are described in Table 3-1.

![Figure 3-4. DB-9 Connector Pins](image)

**TABLE 3-1. i.LON 100 Server DB-9 Pin Assignment**

<table>
<thead>
<tr>
<th>i.LON 100 DB-9 (DTE) Pin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>NC (No connect)</td>
</tr>
<tr>
<td>2</td>
<td>RxD (Receive Data)</td>
</tr>
<tr>
<td>3</td>
<td>TxD (Transmit Data)</td>
</tr>
<tr>
<td>4</td>
<td>NC (No connect)</td>
</tr>
<tr>
<td>5</td>
<td>GND (Ground)</td>
</tr>
<tr>
<td>6</td>
<td>NC (No connect)</td>
</tr>
<tr>
<td>7</td>
<td>NC (No connect)</td>
</tr>
<tr>
<td>8</td>
<td>NC (No connect)</td>
</tr>
<tr>
<td>9</td>
<td>NC (No connect)</td>
</tr>
<tr>
<td>DB-9 Shell</td>
<td>Earth Ground</td>
</tr>
</tbody>
</table>

RS-485 Serial Port

The i.LON 100 server includes one isolated RS-485 multi-drop bus port implemented on terminals 26 through 28.

These are polarity sensitive signals, and the (+) and (−) connections are noted adjacent to the terminals. Since RS-485 is susceptible to common mode ground differential voltage swings, it is imperative that you use a suitable shielded cable when connecting RS-485 based devices. Reversing the polarity of the RS-485 bus will cause improper bus operation and must be avoided. The connector pins are described in Table 3-2.

**TABLE 3-2. i.LON 100 RS-485 Pin Assignment**

<table>
<thead>
<tr>
<th>i.LON 100 RS-485 Pin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>26</td>
<td>Shield Grounds</td>
</tr>
<tr>
<td>27</td>
<td>RT−</td>
</tr>
<tr>
<td>28</td>
<td>RT+</td>
</tr>
</tbody>
</table>

Connecting RS-485 to the ModBus

The 1301 genset control contains data that can be read using ModBus RTU protocol on a two-wire RS-485 master/slave multi-drop bus. In this arrangement, the remote device (PowerCommand iWatch 100) is the master and the 1301 is the slave.

The 1301 is configured at a baud rate of 19,200, 8 data bits, even parity, and 1 stop bit.

For more information about ModBus RS-485 communications, refer to the ModBus Application Protocol v1.1a and the ModBus Serial Line Implementation Guide v1.0; both are available at [www.modbus.org](http://www.modbus.org).

**TABLE 3-3. i.LON 100 RS-485 Pin Assignment**

<table>
<thead>
<tr>
<th>1301 TB2 Connector</th>
<th>i.LON 100 Hi (+) Pins</th>
<th>i.LON 100 Lo (−) Pins</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>28</td>
<td>27</td>
</tr>
<tr>
<td>4</td>
<td>27</td>
<td>26</td>
</tr>
</tbody>
</table>
FIGURE 3-5. PCC1301 CONTROL BOARD WITH RS-485 COMMUNICATIONS PORT

TABLE 3-4. TB2 CONNECTIONS FOR RS-485 MODBUS COMMUNICATIONS

<table>
<thead>
<tr>
<th>Connector Pin</th>
<th>Signal Name</th>
<th>Connected To</th>
</tr>
</thead>
<tbody>
<tr>
<td>TB2-1</td>
<td>RETURN</td>
<td>Network Power Supply Return</td>
</tr>
<tr>
<td>TB2-2</td>
<td>BAT+</td>
<td>Network Power Supply</td>
</tr>
<tr>
<td>TB2-3</td>
<td>RS485 DATA A (+)</td>
<td>Network Data A</td>
</tr>
<tr>
<td>TB2-4</td>
<td>RS485 DATA B (−)</td>
<td>Network Data B</td>
</tr>
<tr>
<td>TB2-5</td>
<td>WAKE_UP_INPUT</td>
<td>Active Low Wake-Up Signal</td>
</tr>
</tbody>
</table>

**NOTE:** Active Low Wake-Up signal (TB2-5) and Network Power Supply Return (TB2-1) can be tied together. Communication cable shield may be connected to TB2-1. Cummins recommends Belden 9729 cable for ModBus communications.
The RJ-11 Telephone Line Port

**WARNING** The i.LON 100 Internet Server telephone modem should be used only with telephone circuits equipped with proper lightning and transient protection circuitry. This minimizes the risk of shock or damage should lightning strike on or near a telephone circuit to which the i.LON 100 Internet Server is connected.

This connector must be used with a suitable male RJ-11 connector that is connected to a two-wire POTS connection that is compatible with the V.90 internal analog modem. The i.LON 100 server analog modem is not compatible with ISDN circuits.

**CAUTION** To reduce the risk of fire, use only No. 26 AWG or larger telecommunication line cord.

High Voltage Mains Power

**WARNING** AC power within the i.LON 100 server presents a shock hazard that can cause severe personal injury or death. Make sure the AC power mains are turned OFF before removing the cover, handling the mains wiring, or connecting any mains cabling to the i.LON 100 server device.

DO NOT under any circumstances operate the i.LON 100 server device to mains voltages outside of the range 90–230VAC, −10% to +30%, 50/60Hz ±2.5Hz.

**WARNING** When connecting a unit, always connect earth ground first, then Neutral, then Line. This minimizes the risk of shock or equipment damage should power inadvertently be present on Line.

**CAUTION** There is a risk of explosion if the battery is replaced by an incorrect type. Dispose of used batteries in accordance to the instructions.

**WARNING** The i.LON 100 server is not equipped with a power disconnect device. When the device is installed and mounted, the installer must provide a means to safely remove power, such as a power switch or a circuit breaker.

**WARNING** The high-voltage terminal block has a plastic cover protecting the screw terminals used to connect the high-voltage inputs. This cover MUST be replaced after the power wires are connected and before the power is activated.

The 90–230VAC power mains connection is used to power the i.LON 100 Internet Server. The i.LON 100 server contains an auto-ranging, auto-setting mains power supply. It is not necessary to adjust any jumpers or other settings when connecting mains voltage.

The high voltage connection is implemented on screw terminals 1 (earth ground), 3 (Neutral), and 4 (Line): screw terminal 2 (NC) is not used and should remain unconnected. A solid earth ground via terminal 1 connection is required for proper ESD and EMC performance of the i.LON 100 device. Use the following order for installation.

1. Insert the earth ground;
2. Insert the neutral connection; and then
3. Insert the line connection.

DO NOT apply power to the i.LON 100 server until you have checked all wiring connections.

**NOTE:** Cummins Power Generation recommends connecting the PowerCommand iWatch 100 to a UPS so the unit does not lose power during a utility failure or transition from utility to a back-up source.

![FIGURE 3-6. i.LON 100 SERVER HIGH VOLTAGE MAINS SCREW TERMINALS](image-url)
TABLE 3-5. i.LON 100 SERVER AC POWER MAINS CONNECTIONS

<table>
<thead>
<tr>
<th>Screw Terminal</th>
<th>Enclosure Marking</th>
<th>Mains Connection</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>E</td>
<td>Earth ground</td>
</tr>
<tr>
<td>2</td>
<td>NC</td>
<td>Do not connect</td>
</tr>
<tr>
<td>3</td>
<td>N</td>
<td>Neutral</td>
</tr>
<tr>
<td>4</td>
<td>L</td>
<td>Line</td>
</tr>
</tbody>
</table>

**LonWorks Network**

The i.LON 100 server is provided with a TP/FT-10 free topology twisted pair LonWorks channel. The PowerCommand iWatch 100 is a TP/FT-10 device. The TP/FT-10 free topology twisted pair interface is polarity-insensitive and requires connecting the twisted pair to terminals 17 and 18 (see Figure 3-7).

FIGURE 3-7. i.LON 100 SERVER LONWORKS TP/FT-10 FREE TOPOLOGY TWISTED PAIR TERMINALS

TABLE 3-6. i.LON 100 SERVER LONWORKS TP/FT-10 NETWORK CONNECTIONS

<table>
<thead>
<tr>
<th>Screw Terminal</th>
<th>Enclosure Marking</th>
<th>LONWORKS Network Connection</th>
</tr>
</thead>
<tbody>
<tr>
<td>17</td>
<td>LON B</td>
<td>TP/FT-10 twisted pair</td>
</tr>
<tr>
<td>18</td>
<td>LON A</td>
<td>TP/FT-10 twisted pair</td>
</tr>
</tbody>
</table>

**Wiring Diagrams**

Figures 3-8 through 3-11 show the genset control wiring to the PowerCommand iWatch 100.
DIGITAL INPUTS ARE POLARITY SENSITIVE

MAX LOAD: 230 VAC, 10 AMPS OR 24 VDC, 10 AMPS
MIN LOAD: 5V, 5 MA

FIGURE 3-8. POWERCOMMAND iWATCH 100 WITH POWERCOMMAND 3100 CONTROL

FIGURE 3-9. POWERCOMMAND iWATCH 100 WITH POWERCOMMAND 2100 CONTROL
DIGITAL INPUTS ARE POLARITY SENSITIVE

MAX LOAD: 230 VAC, 10 AMPS OR 24 VDC, 10 AMPS
MIN LOAD: 5V, 5 MA

FIGURE 3-10. POWERCOMMAND iWATCH 100 WITH POWERCOMMAND 3200 CONTROL

FIGURE 3-11. POWERCOMMAND iWATCH 100 WITH POWERCOMMAND 1.X, 2.X, 3.X CONTROL
4. Connecting the i.LON100e3 to the Network and Commissioning the PowerCommand iWatch 100

CONFIGURING A POWERCOMMAND iWATCH 100

The following steps are necessary to configure a PowerCommand iWatch™ 100:

- Creating a project folder and copying the image.
- Updating project settings.
- Loading the i.LON 100 Image.
- Creating an xDriver RNI.
- Opening a copy of the template database.
- Commissioning the Devices.
- Browsing the PowerCommand iWatch 100.

CREATING A PROJECT FOLDER AND COPYING THE IMAGE

It is important to maintain a record of projects and project settings. The first step is to create a project folder where you can store a copy of the i.LON image that you want to customize for the project. You should give the project folder a name that will allow you to easily associate the folder with the projects.

For example, you may create a folder called: C:\PowerCommand iWatch 3 02 20 04\Projects\Project Name\. Using Windows Explorer, copy the required PowerCommand iWatch 100 image from the CD into the folder you created. There are two images on the CD. One image is for the 2100, 3100 and 3200 genset controls, and the other image is for the 13xx genset controls. Both images have the ability to display ATS and a DIM module.

UPDATING PROJECT SETTINGS

In order to edit project settings:

1. Use Windows Explorer to open the project folder you created above: (C:\PowerCommand iWatch 3 02 20 04\Projects\Project Name\).

2. Open the Web folder followed by the “user” folder and “cpg” folder as shown below: C:\Power....\Projects\Project Name\Image\Web\User\C P G\.

3. Open the config.xml file using Microsoft Word. To do this:
   a. Right click on Config.xml.
   b. Select Open With.
   c. Choose Microsoft Office Word (see Figure 4-1).
4. The word document will open (see Figure 4-2).

**NOTE:** If the document does not open as shown in Figure 4-2, or if you do not have Microsoft Word, the config.xml file can also be edited with either NotePad or WordPad. If you are not editing the file using one of these other options, you must not alter the tag names. For example, `<site_code>` is the beginning tag for the `site_code` field and `<site_code>` is the end tag of the field. If you modify either the beginning or end tags, the config.xml file cannot be read correctly.
5. Change the following settings in the config.xml file as required for the customer:

- **Site Code.** (32 characters, case sensitive). This code can be found on the CD that came with your PowerCommand iWatch 100. If you do not enter this code, you will have to type in the code each time you view the web pages.

- **Site Name.** This is the name that appears on the online diagram page. If you have multiple sites, you may wish to rename this to the name of the site you are viewing. You may have up to 32 characters.

- **Number of Generators.** This can be changed from one to four. It is possible to have a PowerCommand iWatch 100 display more than four generators. However, it is a custom configuration and requires a factory configured unit.

- **Number of ATSs.** This has the range 0 – 4. It is possible to have a PowerCommand iWatch 100 display more than four ATSs. However, it is a custom configuration and requires a factory configured unit.

- **Digital IO.** This option allows you to use digital inputs and outputs that are on the PowerCommand iWatch 100 or a Digital input output module. This field can either be yes or no. The PowerCommand iWatch 100 can communicate with one DIM.

- **Metric.** This field is for the display units. There are three options here: yes, no, and ask. Select Yes to display metric units, No to display imperial units, and Ask to ask the user which units they want when they first access the web pages.

- **Genset and ATS Names.** Each device has a label field that can be changed. You can use 16 characters for the genset name, and 20 characters for the ATS name.

6. Save and close the config.xml file. If you are using Microsoft Word to edit the file, select **Continue** when prompted that the file is not a word document.

If you have Digital I/O, you may also modify the xml file to rename the inputs/outputs, change indicator colors, and change the text on the relay labels from their default (activate/deactivate). The file for this is called digitalIO.xml. It is also located in C:\power\.....\Projects\Project Name\Web\User\CPG. As you did with the Config.xml, right click on file name DigitalIO.xml in Windows Explorer, and open it with Microsoft Word in order to make modifications.

Each point has the following configurable fields:

- **Label.** This field is the description of the point that appears on the digital I/O page and the digital control page. This field will display 21 characters.

- **led_off.** This is the LED image that is displayed when the point is in the off state. The default value is “../../images/CPG/LED_Grey.gif”. This should only be changed if you wish to change the state of the point to active off. Available options are listed in a later paragraph, “LED Images”.

- **led_on.** This is the LED image that is displayed when the point is in the on state. The default value is “../../images/CPG/LED_RED.gif.” Available options are listed in a later paragraph, “LED Images”.

- **relay_off.** This is the button image that is displayed on the control page when the relay is off. There is only a value in this field if the point is an output. The default value for outputs is “../../images/CPG/Buttons/Small/Activate.gif”.

- **relay_on.** This is the button image that is displayed on the control page when the relay is on. There is only a value in this field if the point is an output. The default value for outputs is “../../images/CPG/Buttons/Small/Deactivate.gif”.

- **nv_in.** This field should not be changed. If it is changed, the point may not function correctly. This is the network variable that is used for displaying the state of an input or output network variable.

- **nv_out.** This field should not be changed. If it is changed, the point may not function correctly. This is the network variable that is used for control of the output.
**LED Images:**

The following images can be used for LEDs. The color of the LED follows LED_ in the file name. If _Flash follows the color, the LED will flash at approximately 1 Hz:

- //images/CPG/LED_Grey.gif
- //images/CPG/LED_Green.gif
- //images/CPG/LED_Yellow.gif
- //images/CPG/LED_Red.gif
- //images/CPG/LED_Green_Flash.gif
- //images/CPG/LED_Yellow_Flash.gif
- //images/CPG/LED_Red_Flash.gif

**Relay Button Images:**

The following images can be used for the relay control buttons. The name of the gif file is the text that appears on a blue button. Other images could be used as long as they are 110 x 31 pixels and have been placed in the "web\images\CPG\Buttons\Small" folder on the PowerCommand iWatch 100.

- //images/CPG/Buttons/Small/Activate.gif
- //images/CPG/Buttons/Small/Deactivate.gif
- //images/CPG/Buttons/Small/Start.gif
- //images/CPG/Buttons/Small/Stop.gif

Save and close the DigitalIO.xml file. If you are using Microsoft Word to edit the file, select Continue when prompted that the file is not a Word document.

**LOADING THE i.LON 100 IMAGE**

The following steps are required to prepare the i.LON 100 and load the PowerCommand iWatch 100 image.

1. Connect the i.LON 100 to your PC using a DB-9 null modem cable between the PC’s COM port and the i.LON 100’s console port. (If you have just applied power to the iLon100, it takes two minutes to boot-up.)

2. Connect the i.LON 100 to your PC using an Ethernet patch cable or Ethernet crossover cable. From your PC’s Ethernet Port, connect the cable directly to the i.LON 100’s Ethernet port. (This will keep your laptop and the i.LON 100 isolated from the customer’s LAN/WAN-while configuring it.) Be sure the LAN “link” light on the iLon is illuminated.

3. Format the i.LON 100.

4. FTP the image.

**Formatting the i.LON 100**

Once the i.LON 100 is connected to the PC, open Hyper Terminal and connect to the i.LON 100. To do this:

1. Click on Start→All Programs→Accessories→Communication→HyperTerminal

2. If asked to make HyperTerminal your default telnet program, select No.
3. Name the HyperTerminal connection iWatch. (see Figure 4-3). In that way you can open it again without having to remember your settings.

4. Once you have named the connection, click OK.

5. The HyperTerminal displays a list of available COM ports for your computer (see Figure 4-4). Select the serial communication port to which you connected the i.LON 100, then click OK.

6. Assign the following communications port settings (see Figure 4-5):
   - Bits per second = 9600
   - Data Bits = 8
   - Parity = No Parity
   - Stop Bit = 1
   - Flow Control, NONE.

7. Click OK to continue.

8. You should now be connected to the i.LON 100 console. If the i.LON 100 has finished boot up, press Enter.

9. The i.LON 100 prompt should appear: (iLon100>). If nothing appears, check your connections and settings. If you see other information on the screen, wait for the i.LON 100 to finish booting.
The i.LON 100 needs to be formatted before sending it an image. To format:

1. Type **Format** at the HyperTerminal prompt (see Figure 4-6), and then press **Enter**.

2. Answer “y” and press **Enter** when asked if you want to proceed with the format.

After formatting the i.LON 100, it will go into the BOOTROM mode. In this mode, you can only reboot, set the IP Address, subnet mask, and transfer files. Other operations are not permitted.

1. Verify the IP Address. The IP address will be displayed when the i.LON 100 finishes rebooting (see Figure 4-7).

2. You can also type **show**, and press **Enter** to see the information shown in Figure 4-7.
NOTE: Figure 4-7 shows you what IP address is assigned to your iLon and other information. Every iLon100 comes from the factory with the IP address 192.168.1.222 assigned.

NOTE: Leave HyperTerminal running until the project is completely finished; it is a very useful tool. You can minimize the window if you need to use other applications.

3. Set your computer IP address to 192.168.1.25 with a subnet mask of 255.255.255.0.

Setting a Static IP Address on your Computer

You can set a static IP address on your computer by using the following steps:

1. On the desktop of your computer, right click on My Network Places and select Properties. A window is displayed (see Figure 4-8).

NOTE: Before you can proceed, your PC’s Ethernet port must be connected to another live Ethernet port on another piece of equipment in order to dynamically change or set a static IP address on your PC. In this case you should be connected directly to the i.LON 100 using either a patch or crossover cable. The i.LON 100 will automatically reconfigure its port to accept either type of cable. If you are not connected to a live Ethernet port, you will be required to reboot your PC before the changes take place (see Figure 4-8). If you are connected to a live port, the Status column should show “Connected”.

2. Select your wired connection, right click, and select Properties.

![FIGURE 4-8. NETWORK CONNECTIONS PROPERTIES WINDOW](image)
3. A window is displayed (see Figure 4-9). Scroll down to “Internet Protocol (TCP/IP)”, select it, and click **Properties**.

4. Click the **Use the following IP address** radio button.

5. Fill in the IP address and subnet mask as shown in Figure 4-10.

6. Click **OK**.

7. Click **Close** at the next window. WXP may take some time to complete this process.

---

You need to know what subnet you require before you can assign one to your computer. To connect to an i.LON 100 right out of the box, you need the 192.168.1 subnet.

The example in Figure 4-10 assigns .25 to this PC. You may use numbers between 25 and 253. You may not use an address already assigned to another device on the same subnet. Therefore, you may not use .222, because it is already assigned to the ILon.
You now have a static address assigned to your computer. Make sure to repeat this procedure again when you are done, and select *Obtain an IP address automatically*, or you may have trouble connecting to your company’s LAN.

**Ping Test**

To ping a device on the Ethernet, follow these instructions:

1. Click Start→Run.

2. Enter `cmd` as shown in the Run window. A command prompt window opens (see Figure 4-11).

![Figure 4-11. Command Prompt Window](image)
3. Try to ping a device on your subnet (192.168.1.x). Type **ping 192.168.1.222**, and press **Enter** (see Figure 4-12). If the device is alive, you should get four replies, proving the ping test is successful (see Figure 4-13).

![Figure 4-12. Pinging a device on the subnet](image1.png)

![Figure 4-13. Ping test successful](image2.png)
FTP Transfer

Now you can open the Internet Browser (Internet Explorer), and type the following command to open the FTP site: ftp://192.168.1.222. The iLon100 will require you to log-in. The default ID is ilon. The default PW is ilon (see Figure 4-14).

FIGURE 4-14. FTP LOG-IN
After opening the site, you should see only three folders (see Figure 4-15). **Make sure you have closed all xml files before you initiate the FTP transfer.**

1. Copy the contents of the PowerCommand iWatch100 project folder and paste to the FTP site.

**NOTE:** It is important to copy only the contents of the image folder when you FTP your project folder files to the PowerCommand iWatch 100.

---

**FIGURE 4-15. FTP SITE**
2. You should be asked if you want to overwrite existing files. Choose yes to all. Although a long transfer time may be indicated, it should take less than 15 minutes.

3. When copying is complete, go back to the HyperTerminal prompt and type reboot.

4. Choose "y" to confirm you want to reboot the i.LON100. This should take approximately two minutes.

5. After the i.LON100 is finished booting up, its address changes to 192.168.0.5. This address is defined in the image files created by Cummins. You will need to set the IP address with the customer's requirements using the hyperterminal connection and the ipaddress command. You must also change the static address of your computer to match the subnet (xxx.xxx.xxx.25) that you eventually assign to the i.Lon100.

CREATING AN XDRIVER REMOTE NETWORK INTERFACE

The i.LON 100 can be used as a remote network interface (RNI). The RNI takes the place of a PCC10 network interface. To create an xDriver Remote Network Interface, start by opening “LonWorks Interfaces” in the control panel.

1. Click Start, then click on Control Panel.

2. Double click on LonWorks Interface (see Figure 4-16).

3. When the “LonWorks Interfaces” page opens, make sure the RNI tab is selected.

FIGURE 4-16. LONWORKS INTERFACE ICON
4. Make sure “Default” is selected (see Figure 4-17).

5. Click **Add** to install a new RNI.

6. Name the Network Interface iWatch, and click **Next** (see Figure 4-18).

7. On the “Network Interface Type” window, choose **Other**, and click **Next** (see Figure 4-19).
8. Enter the PowerCommand iWatch 100 IP Address, 192.168.0.5, or the customer defined address previously assigned to the PowerCommand iWatch 100 in HyperTerminal, then click **Finish** (see Figure 4-20).

9. After finishing the set-up of a new RNI, select the x.default.iWatch name and click the **Test** button. Then click **Start**. Upon successful completion of this test, you will see “xDriver diagnostics test passed” in the bottom of the dialog box.

**NOTE:** If the test did not pass:
- The address you assigned to the xDriver does not match the address assigned to the PowerCommand iWatch 100
- A problem exists with the Ethernet cable connection between your computer and the PowerCommand iWatch 100
- The PowerCommand iWatch 100 is not powered
- The IP address subnet setting on your computer is not the same as the PowerCommand iWatch 100 (xxx.xxx.xxx)

![Add Network Interface Wizard - IP Address](image)

*FIGURE 4-20. ENTERING THE IP ADDRESS*
OPENING A COPY OF THE TEMPLATE DATABASES

Three template databases have been included on the PowerCommand iWatch 100 CD:

- IW100E3A2100, 2100 Gensets and OTPC ATS
- IW100E3A3100, 3100 Gensets and OTPC ATS
- IW100E3A3200, 3200 Gensets and OTPC ATS

**NOTE:** If you have different combinations, select the template that best fits your application and customize it.

For first time use, restore the databases from the backups.

1. Copy the database backups to your C:\LM\backup\ folder.

2. Open LonMaker for Windows from the Start Menu by choosing Start—Programs—LonMaker for Windows, or you can use the shortcut icon on the desktop.

3. Click the **Restore** button, and browse to the template databases.

4. Follow the prompts to restore the database.

**NOTE:** You will **not need** to open the database or re-commission devices, so answer **No** when prompted to do so.

5. Once you have restored the template databases, select the template database you want to use.

6. Select **Open Copy**.

7. When asked if you want to continue, click **Yes** (see Figure 4-21).

![FIGURE 4-21. OPENING A TEMPLATE DATABASE](image-url)
8. After choosing to continue, enter a network name for this project. Give your database a name that will allow you to associate the network with the project (see Figure 4-22). Click **Next**.

![Figure 4-22. Renaming Your Network](image)

9. When the box shown in Figure 4-23 appears, make sure that **Network Attached** is unchecked. If checked, deselect it, then click **Next**.

![Figure 4-23. Network Attached Not Selected](image)

10. Click **Next**. The box in Figure 4-24 appears.

![Figure 4-24. Domain Definition](image)

11. Leave the “Domain Length” at the default value of 1, and the **Use randomly generated domain ID** checked. Then click **Finish**.
Once the database is opened and saved, you can connect to the network interface as follows:

1. Select the LonMaker Menu and then Network Properties (see Figure 4-25.)

2. On the Network Properties box, select the “Network Interface” tab (see Figure 4-26).
3. Check **Network Attached**.

4. Choose `x.Default.iWatch` from the dropdown list of interfaces, and click **OK**.

**NOTE:** When you click **OK**, you may need to upgrade your network interface.

5. If you see the message shown in Figure 4-27, select **Yes**.

---

**FIGURE 4-26. NETWORK INTERFACE**

**FIGURE 4-27. NETWORK INTERFACE UPGRADE**
6. Reopen the Network Properties box, and select the “Onnet/Offnet” tab (see Figure 4-28).
7. Select Onnet and click OK. The Network Interface should change from yellow to green (see Figure 4-29).
COMMISSIONING THE DEVICES

To commission devices, you first start with the i.LON 100. The i.LON100 is commissioned using the following procedure:

1. Right click on the PowerCommand iWatch 100 device, and select **Commission** from the menu (see Figure 4-30).

2. When you choose “Commission”, options will appear on the Commission Device Wizard box (see Figure 4-31). Choose **Online** for a “State.”

3. The “Source of Configuration Property Values” is not important. Click **Next**.

**FIGURE 4-30. COMMISSIONING THE i.LON 100**

**FIGURE 4-31. SELECTING ONLINE FOR STATE**
4. Select **Service Pin** as the device identification method, then click **Finish** (see Figure 4-32).

5. When prompted, press the service pin on the i.LON100.

6. Once the commissioning process is complete, the i.LON100 should turn green if it was successful.

7. Repeat the commissioning process for all other devices present.

8. Reset all devices either through LonMaker or the device’s reset pin.

9. Save and close LonMaker for Windows.

**Set the PowerCommand iWatch 100 IP Address.**

To set the PowerCommand iWatch IP address, use the following procedure:

1. Switch to the HyperTerminal session.

2. Assign the customer’s IP address to the PowerCommand iWatch 100 using the following commands:

   - `Ipaddress xxx.xxx.xxx.xxx`
   - `Subnet xxx.xxx.xxx.xxx`
   - `Gateway xxx.xxx.xxx.xxx`
   - `DNSprimary xxx.xxx.xxx.xxx`

**NOTE:** All commands must be followed by the customer’s specified settings. The DNS address is required if you need to send e-mail via a named e-mail server.
THE CUSTOMER’S CONFIGURATION

The following procedure allows you to connect the PowerCommand iWatch 100 to the Customer’s network. If you are going to use the PC that you used to configure the PowerCommand iWatch 100, you will need to connect your PC to the customer’s network and set your PC to obtain an IP address automatically.

1. Open the internet browser (Explorer).
2. Type the following in the address bar: http://xxx.xxx.xxx.xxx, (xxx.xxx.xxx.xxx is the address you assigned the PowerCommand iWatch 100.)
3. When the new page opens, choose Service, which will allow you to enter the customer’s configuration requirements (see Figure 4-33).

FIGURE 4-33. SERVICE OPTION FOR CUSTOMER CONFIGURATION REQUIREMENTS
The following additional network LAN/WAN setup procedure allows you to verify:

- IP Address, Subnet Mask and Gateway
- DNS server IP Address
- SMTP server
- E-mail account information
- Modem setup

1. From the web page, choose Service (see Figure 4-33).

2. You must log-in to the PowerCommand iWatch 100. The default ID is ilon, and the default PW is ilon.

3. Under setup choose:
   a. Network—LAN/WAN
   b. On the tree in the left hand pane under LAN, select “mail.company.com” (see Figure 4-34).

4. Provide the name of the customer’s mail server in “Server Property Value” (see Figure 4-34).

5. On the tree in the left hand pane of the page, click Email (Default) and provide the required information. Be sure to contact the customer’s IT department to get the correct information for Server Email Address and User Name and Password, if required.

6. When you are finished, click Submit for all changes to take effect. The requested information is displayed (see Figure 4-35).

FIGURE 4-34. LAN/WAN NETWORK SETUP
FIGURE 4-35. E-MAIL DEFAULT OPTION
After the changes are made, you need to verify that the information is correct. To do this:

1. Click Setup→Verify. The screen in Figure 4-36 appears.

2. At “Send test email to,” fill in your e-mail address or someone else’s to verify that the SMTP server connection is working correctly.

3. You only need to check the e-mail and LAN connections. Deselect the other choices (see Figure 4-36).

4. Click Start Tests.

It is possible that one of the following functions might go wrong:

- No DNS server address entered
- Unable to access the DNS server
- Unable to access the mail server
- Sender e-mail address invalid

NOTE: The PowerCommand iWatch 100 must be connected to the customer’s LAN/WAN for these tests to work.

![Figure 4-36. E-Mail and LAN Test Connections](image-url)
**DIAL-UP CONNECTION**

An PowerCommand iWatch 100 webserver installation can include an optional built-in modem that provides a direct dial-in connection to the PowerCommand iWatch 100’s web pages. This section provides information on setting up configuration parameters for a direct dial-in to the PowerCommand iWatch 100.

**NOTE:** The PowerCommand iWatch 100 internal analog modem is not compatible with ISDN circuits.

To set up the PowerCommand iWatch 100 for direct dial-in to the web pages,

1. Open Internet Explorer and enter the following URL:
   
   http://xxx.xxx.xxx.xxx (IP address of the PowerCommand iWatch 100)

2. Click on **Service**.

3. Log-in and enter the user name and password (see Figure 4-37).

   Username: ilon
   Password: ilon

   ![Figure 4-37. Username and Password](image)

4. Place the cursor over **Setup** and select **Modem** from the drop-down list.
5. For the modem type, select **Internal Analog**. (see Figure 4-38).

6. Click on the **Submit** button.

7. On your PC, open the **Start** → **Connect To** program. Click on **Show all connections** and select **Create a new connection** from the left hand side.

8. Follow the Wizard to set up the new connection.
   a. Select **Connect to the Internet**.
   b. Select **Set up my connection manually**.
   c. Select **Connect using a dial up modem**.
   d. ISP Name = ilon
   e. Phone number = the number of the land line your i.LON 100 is connected to
   f. Username = ilon (This is setup in the built-in web pages as shown above)
   g. Password = ilon (This is set up in the built-in web pages as shown above)
   h. Click on **Finish**.

![FIGURE 4-38. MODEM SETUP](image)
5. PowerCommand iWatch 100 Web Pages

INTRODUCTION

This section describes and shows the flow and functions of the PowerCommand iWatch™ 100 web pages used for monitoring and controlling the network devices.

IMPORTANT POWERCOMMAND iWATCH 100 WEB PAGE INFORMATION

Units of Measurements – You can select either a Metric or Imperial System of measurement. If you did not configure the units of measurements through the XML file, then you will be prompted for the units at the launching of this page.

FIGURE 5-1. SELECTING UNITS OF MEASUREMENT
To view the PowerCommand iWatch 100’s web pages:

1. Open Internet Explorer.

2. Type in the IP address of the PowerCommand iWatch 100.

   http://xxx.xxx.xxx.xxx

   **NOTE:** “xxx.xxx.xxx.xxx” refers to the address assigned to the PowerCommand iWatch 100 by the installer.

3. Choose **Standard** on the screen. See figure 5-2.

4. Save this link as one of your Internet Favorites for quick access in the future.

Figure 5-3 shows the configuration of one genset and one transfer switch configured through the XML file as described in Chapter 4.
GENSET WEB PAGES

There is a Generator Summary page available for each of the four separate generators. Each generator summary page includes a link to its Annunciator page. This means there is a total of eight web pages that can be used to monitor up to four generators. They all can be used to monitor different variables and display the various states of the genset.

Genset AC Data and Engine Data

To view the Generator Summary page from the OneLine web page, select View → Generator Summary, or click on the Summary button above the generator graphic. The Generator Summary page displays Genset AC Data and Engine Data (see Figure 5-4).

Genset Annunciator Data

To view the Generator Annunciator web page from the Generator Summary web page, click on the Annunciator button above the generator graphic. The Genset Virtual Annunciator web page (see Figure 5-5) displays active NFPA110 and the extended set of generator alarms. This web page displays more information than a standard annunciator displays. For information on alarm notification, see Section 6.

FIGURE 5-4. GENSET AC AND ENGINE DATA PAGE

FIGURE 5-5. GENSET ANNUNCIATOR DATA WEB PAGE

Digital I/O Web Page

To view the Digital I/O web page from the OneLine web page, select View → Digital I/O.

The Digital I/O web page shows the status of both the PowerCommand iWatch 100's on-board inputs and outputs, and the DIM's inputs and outputs. See figure 5-6.

FIGURE 5-6. DIGITAL I/O WEB PAGE

ATS WEB PAGES

There is an ATS summary page available for each of the four separate transfer switches. Each ATS summary page includes a link to its Annunciator page. This amounts to a total of eight web pages that can be used to monitor up to four transfer switches. They all provide the functionality of monitoring different variables and displaying the various states of the ATS(s).

ATS AC Data

To view the ATS Summary web page from the OneLine web page, select View → ATS Summary, or click on the Summary button above the ATS graphic.

This web page displays the values for both AC sources and the load side of the transfer switch.
NOTE: A level 2 OTPC switch control with the load monitoring package installed is required to provide all of the data shown in Figure 5-7. If the load monitoring package is not installed, the load side data will show 65,535 for voltages, and 32,767 for currents.

FIGURE 5-7. ATS SOURCE AND LOAD DATA

ATS Annunciator

To view the ATS Annunciator web page from the ATS Summary web page, click on the Annunciator button above the ATS graphic.

The ATS Virtual Annunciator web page displays active NFPA110 and the extended set of ATS alarms. This web page displays more information than a standard annunciator displays. For information on alarm notification, see Section 6.

FIGURE 5-8. ATS ANNUNCIATOR PAGE
CONTROLS WEB PAGE

The Controls web page is a secure web page where control functions for the genset, ATS, DIM, and PowerCommand iWatch 100 on-board outputs are found.

The Controls web page for the gensets and ATS (see Figure 5-9) allows the user to issue remote start and reset commands for the gensets, and test and fault reset commands for the transfer switches.

The Controls web page for the DIM and PowerCommand iWatch 100's on-board outputs (see Figure 5-10) allows the user to activate the DIM relays and the PowerCommand iWatch 100 on-board relays.

To access the Control function pages, the user will be required to log-in to the PowerCommand iWatch 100. See Section 7 for instructions on how to make changes to the default log-in credentials.

NOTE: The PC that logged into the PowerCommand iWatch 100 stays logged in until either logged out using the Log-off button at the far upper right of the webpage, or all Internet Explorer sessions are closed. Cummins Power Generation recommends always using the Log-off button to ensure that control functions are protected by a secure log-on procedure.

From the main page, select Control → Genset & ATS, or Control → Control (for the DIM and PowerCommand iWatch 100 on-board relays).

NOTE: The 1301 control currently does not support fault reset commands through the ModBus registers.

NOTE: Any command issued to the genset, ATS, or DIM via the PowerCommand iWatch Control web page will need to be deactivated from the PowerCommand iWatch Control web page interface. Commands turning functions on will be on continuously until turned off through the Control web page. These commands do not deactivate when the web page is closed.
FIGURE 5-10. RELAY OUTPUTS
The Alarm Summary page is used to acknowledge and clear alarms. To acknowledge an alarm, check the Ack box and click on Submit. All alarms have an acknowledgment-required default setting. If you would like to change the default acknowledge and clear alarm settings, refer to the previous section. For more information on Alarm Summary, refer to i.LON 100 Web Page User’s Guide.

1. Open Internet Explorer.
2. Go to your PowerCommand iWatch 100’s IP address.
3. Log in to the i.LON 100.
4. Place the cursor over View and select Alarm Summary from the drop-down list.
ALARM HISTORY WEBPAGE

The Alarm History web page is a versatile page for viewing Alarm History. It defaults to show the history of one alarm, but can easily be set up to show the last 50 alarms, date range of alarms, or the history of one specific alarm. The page also allows the user to keep track of the amount of memory the alarm logs are using and allows for erasing some or all of these logs.

These logs can also be configured to be a circular file. That is, once the user sets a certain memory limit, the i.LON 100 sends an e-mail with the attachment of the log(s) to the e-mail recipient and starts a new log. For more information on this feature and Alarm History, refer to the i.LON 100 Web Page User’s Guide.

To view the Alarm History web page,

1. Open Internet Explorer.
2. Type in your IP address.
3. Choose Standard. from the web page.
4. Place the cursor over Alarm and select Alarm Summary from the drop-down list.

FIGURE 5-12. ALARM HISTORY
6. Alarm Generation and Notification

**INTRODUCTION**

The PowerCommand iWatch™ 100 is pre-set with alarms for all four generators and all four transfer switches: communications failure, fault type, and fault code. If you are commissioning less than all eight of these devices, then you should disable the alarms for the devices that do not exist in your network project.

If you do not disable the alarms for non-existent devices, a communication alarm will be sent each time the PowerCommand iWatch 100 boots up, which could occur from a power failure. After the alarms for non-existent devices are disabled, you should delete the alarm summary and history as these alarms will have already been logged.

There are also 16 alarm inputs on the LonMaker project. You may bind any SNVT switch output to these inputs. You can then custom configure these alarms in the PowerCommand iWatch 100.

Working with the alarm set-up does require patience, because the web pages that you access to make changes take time to load.

**NOTE:** The SMTP setup must be completed for alarms to be delivered. See page 4-24.

**SENDING FAULT CODES AND TYPES VIA E-MAIL**

The PowerCommand iWatch 100 is pre-configured to send fault codes and fault types through e-mail for all of the devices that are connected to the network (except DIM and annunciator modules).

To send e-mails you must first configure your destination e-mail address and e-mail content as follows:

1. Open the browser.
2. Open the PowerCommand iWatch 100 webpage.
3. Choose the **Standard** button (see Figure 6-1).

*FIGURE 6-1. POWERCOMMAND iWATCH 100 WEB PAGE*
4. From the main menu, choose Alarms→Email (see Figure 6-2).

5. When the new window appears, click on Email Alarm. The screen in Figure 6-3 appears.

**NOTE:** Multiple e-mail addresses can be separated by a semi-colon.

6. Enter the destination e-mail address where it says username@company.com.

7. Modify the Subject field if you need a more descriptive name for the site. Default is Power-Command iWatch 100. The following symbols are also included by default in the subject field:

   - %pd – data point description
   - %ua – data point value units
   - %va – data point value

**NOTE:** For a description of the symbols you can add, click on Help at the top of the Alarm Notifier page (see Figure 6-5).

8. In the message field, configure what information you want to send in the e-mail.
Cummins has pre-configured the alarm to send the IP address for this PowerCommand iWatch 100 device in the alarm message. We have also pre-configured the text message instructing the e-mail receiver to go to the PowerCommand iWatch 100 web pages for explanations of the alarms in the e-mail. You may reconfigure this text string to suit your customer’s needs.

To include specific pieces of information from the site in the e-mail, use the Variable substitution area at the bottom of the dialog box. Choose whether you are adding this information to the subject line or to the body of the e-mail.

You can refer to the Help page or the i.LON manual for a complete listing of data you can include in the e-mail.

9. After your e-mail configuration is complete, click OK.

10. Click Submit at the top, left corner of the page.

**DISABLING ALARMS FOR NON-COMMISSIONED LONWORKS DEVICES**

**NOTE:** When you have less than eight devices preconfigured on your network, disable the alarms for non-commissioned devices. Do not delete them.

To disable alarms for non-commissioned devices, use the following procedure:

1. Open the Service webpage (Figure 6-4).
2. Go to the Configure tab, and select Alarm Notifier.

**FIGURE 6-4. SELECTING SERVICE BUTTON ROM WEB PAGE**
3. The AlarmNotifier Dialog Box appears (see Figure 6-5).

4. There are two input arrows on the screen. Click on InputValues.

5. The right-hand pane opens and displays all of the pre-defined alarms. At the top of that pane, select the ShowAdvanced properties radio button.

6. Click the box in the Disabled column next to an alarm to disable it.

7. When finished with making modifications, select Submit in the upper left corner of the screen.

8. If an alarm appears in the Alarm Summary, delete the sumlog1.dat and histlog0.dat files from the PowerCommand iWatch 100. These files are located in the alarm log folder on the PowerCommand iWatch 100.

ALARM ACKNOWLEDGMENT

By default all alarms require an acknowledgement. If you desire to change that default:

1. Navigate to the Alarm Log Data Point webpage (see Figure 6-5).

2. Remove the check for an alarm in the Acknowledgment Required column.

3. Select Submit in the upper left corner of the screen.

---

FIGURE 6-5. ALARM NOTIFIER DIALOG BOX
CUSTOMIZING THE 16 USER DEFINED DIGITAL ALARMS

There are 16 pre-defined digital alarm points that you may assign to network variable outputs. See Figure 6-7. You use these pre-defined digital alarms by binding a digital nvo from a network device to one of the digital alarm points on the PowerCommand iWatch 100 (nvi) and then renaming it.

In the example below, DIM Input 1 is bound to Alarm Point 1. In the i.LON config, this alarm may be named appropriately for the point wired to the DIM input.
To rename alarm points, use the following procedure:

1. Open the internet browser, then the Power-Command iWatch 100 web page.
2. Select Service (see Figure 6-4) to open the Data Point Selection screen (see Figure 6-8).
3. From the main menu, choose Configure → Data Points.
4. On the “Configure Data Points” screen, click on the left hand side (+ sign) next to the i.LON 100 (see Figure 6-9).
5. Next click on the (+ sign) next to NVL.
6. Then click on the (+ sign) next to dynamic. This page loads slowly.
7. A tree will be populated with the names of available alarms. Scroll down until you see customer alarms 1 through 16 (see Figure 6-10).

8. Choose the customer alarm, and rename the Alias name to a name that describes the alarm.

9. Choose the customer alarm, and rename the description to a name that describes the alarm.

10. Save the changes by clicking Submit.

**NOTE:** You can modify multiple alarms before you click Submit.

For another reference on how to configure alarms, please refer to the i.LON 100 User's Guide.
ALARM NOTIFICATION VIA A DIAL-UP PROVIDER

To enable the PowerCommand iWatch 100 to connect to a dial-up provider, use the following procedure. From the Service page:

1. Move your mouse over Network, and click LAN/WAN.

2. In the left hand pane, right click on the i.LON 100 at the top of the tree, and select Add Connection.

3. In the right hand pane, name the new connection.

4. Enter the necessary phone number, user id, and password for connection to your ISP (see Figure 6-11).

5. Right click on the new connection just added in the left hand pane, and select Add Server.

6. Type in the IP Address or name of your SMTP Server (see Figure 6-12).

7. In the left hand pane, right click on the new SMTP server you added, and select Add Service.

FIGURE 6-11. NEW CONNECTION

FIGURE 6-12. NEW SMTP SERVER
8. When the Add Service menu is displayed, select Email (SMTP). Click on OK (see Figure 6-13).

9. Beneath your SMTP server icon is an Email (Default) icon. Click on it and enter your source e-mail address, user name, and password.

10. Click on the Submit button to save this information to the PowerCommand iWatch 100.

E-mails through modem are sent just like the LAN configuration.

ARCHIVING /CAPTURING ALARM LOG DATA

The PowerCommand iWatch 100 stores its log data in a binary file. To copy this data to Excel, follow these steps:

1. Navigate to the log file you are interested in (Summary or History).

2. While viewing the data points, use your mouse to highlight all of the data on the web page you want to capture (hold down left mouse button and swipe mouse over the web page).

3. With your mouse over one of the data points, right click, and select Copy.

4. Open Excel, click on cell A1, right click over cell A1, and select Paste.

You cannot adjust column width and row height. You can manipulate the data to suit your needs.
It is possible to setup different user names and passwords by using iLON100 Web Security.

The PowerCommand iWatch™ 100 comes with two levels of security as the default. Default does not require a log-in in order to view data web pages. However, log-in is required for access to control function web pages. The username *user* and the password *user* are required for access to the control functions. And username *ilon* and the password *ilon* are required to change configuration pages including alarm notification settings.

There is another security file included on the PowerCommand iWatch 100 CD. If loaded, it requires logging in to view the data web pages. The username *guest* and the password *guest* allow viewing PowerCommand iWatch 100 web pages only. Username *user* and password *user* are required for access to the control functions. Username *ilon* and password *ilon* are required for access to configuration pages.

**NOTE:** The PC that logged into the PowerCommand iWatch 100 stays that way until either logged out by means of the Log Off button located at the right side of the web page, or all Internet Explorer sessions are closed. **Cummins Power Generation recommends always using the Log Off button to make sure that control functions are protected by a secure log-on procedure.**

Choose which security file you want to load into the PowerCommand iWatch 100. If you want to use the lower level of security, you already have the file in your project-specific folder in the Image folder. If the project requires the higher level of security, copy the webparams.dat file from the Security Options folder to your project's Image folder.

**ADDING NEW USERS/MODIFYING USER PERMISSIONS**

**NOTE:** Do not make modifications to the files in the security options folder. Modify the security settings in your customer specific project folder.

Cummins Power Generation suggests that you limit modifications of these files to adding and deleting users, and adding and moving users between already defined groups. Directions beyond this point are not provided in this manual.

When you create the project folder, the "no log-in for viewing" web pages is loaded into the PowerCommand iWatch 100 by default. The file where the security settings are located is called webparams.dat. It is located at the root level of the PowerCommand iWatch 100's directory structure.

Modifications can be made directly to this file, or the restricted access security file can be loaded and modified also. The restricted access file is located in the Security Options folder that is copied to your computer when you copy the PowerCommand iWatch 100's CD contents to your PC for the first time: C:\PowerCommandiWatch 3 02 20 04\Security Options.

**NOTE:** Make sure you are using the copy of the webparams.dat file in the project-specific folder. The original files should never be modified.

Open the webparams.dat file in the project folder using this program: "ilon web server security parameter".
You can locate this file as follows:

1. Choose **Start** from your PC.
2. Open **All Programs**.
3. Choose Echelon i.LON 100.

4. Choose "i.LON 100 Web Server Security and Parameters". See Figure 7-1.
5. Choose File → Open.
6. Browse to the location of the webparam file.
7. Open it. See Figure 7-2.

**FIGURE 7-1. WEB SERVER SECURITY AND PARAMETERS**

**FIGURE 7-2. OPEN WEBPARAMS FILE**
The active tab is Users. You will see two users listed at the bottom of the window, or three users if you started with the restricted security file. See Figure 7-3. Create new entries in the following order:

a. Define new User if required
b. Assign user to a group
c. Save the webparams.dat file
d. Copy webparams.dat file back to the PowerCommand iWatch 100 and reboot

FIGURE 7-3. USER’S TAB

Adding a User

To add a user:

1. Select the User’s tab from the i.LON 100 Web Server Parameters main dialog box. The user’s dialog box appears.

2. In the Username field, enter the name of the user you are adding. The username must be unique and cannot include spaces or colons. The limit is 16 characters.

3. Enter the password in the password field. It will appear as asterisks.

4. Re-enter the password to confirm it.

5. Click Add User at the right side of the dialog box. Your new username appears in the window in the lower part of the dialog box.

Deleting a User

NOTE: The user must not be in any group in order to be deleted from the list of users. See the procedure for removing a user from a group.

To delete a user:

1. Select the user’s name from the list in the window.

2. Click Remove at the right side of the dialog box.

Assigning Users to a Group

To assign users to a group:

1. Select the Groups tab from the i.LON 100 Web Server Parameters main dialog box. The Groups dialog box appears.

2. In the Groups window, select the group to which you want to assign users.

3. At the far right of the screen, select the user you want from the list in the user’s window.
4. Click **Add User** at the right side of the dialog box. The username appears in the group window.

**Removing Users from a Group**

To remove a user from a group:

1. Select the Groups tab from the i.LON 100 Web Server Parameters main dialog box. The Groups dialog box appears.

2. In the Groups window, select the group from which you want to remove a user.

3. In the middle window named Users in a Group, select the user you want to remove from the list.

4. Click **Remove**. The username disappears from the list.

**Saving the Webparam.dat File**

**NOTE:** The WebParams.dat file should never be edited with a text editor. The i.LonWebParams program performs consistency checking on the web page security information that you define. A text editor cannot perform the necessary checking.

To save the security profile:

1. From the i.LON 100 Web Server Parameters main dialog box, select “Validate” from the file menu.

2. At the very bottom left of the dialog box, review the Status message. You need to see “All data consistent” before you proceed.

3. If you see another message, fix the problem. Then run “Validate” again.

4. Select **Save**. from the file menu. The Save dialog box appears.

**NOTE:** Do not change the name of the file from WebParams.dat. You should save this file back to the Image folder under the specific project folder you are using.

5. When asked if you want to replace the existing file, click **Yes**.

6. Copy this file back to your PowerCommand iWatch 100 using the FTP process. This file goes at the root of the PowerCommand iWatch 100 directory structure (ftp://xxx.xxx.xxx.xxx).

7. Reboot the PowerCommand iWatch 100 for changes to take effect.
This appendix is a general troubleshooting guide for connecting to the PowerCommand iWatch™ 100 with your computer. The operating system used for this Appendix is Windows XP SP2.

This section is a help section only. Cummins takes no responsibility for any problems that may arise in the use of the information of this section. It is recommended that you contact the customer’s IS/IT group before putting the PowerCommand iWatch 100 on the network.

If you are having troubles setting up the PowerCommand iWatch 100 to the network, it is best to start by connecting it directly to your computer.

**NOTE:** For Cummins Employees using Power-Swept machines, this will require admin rights.

Connecting the PowerCommand iWatch 100 directly to your computer:

1. Plug an Ethernet patch cable from the PowerCommand iWatch 100 directly into your computer.

2. Launch a Command Prompt. Open **Start → Run**, and type **cmd**.

3. Type the command “ipconfig” in the command window. This will display the addresses that your computer has assigned to its Ethernet adapters. Your Local Area Connection must have an address with a compatible subnet to the PowerCommand iWatch 100 (the first three octets must match the PowerCommand iWatch 100’s xxx.xxx.xxx). See Figure A-2.

The subnet mask of your Local Area Connection and the PowerCommand iWatch 100 must match if you are connecting directly from your computer to the PowerCommand iWatch 100.

4. In the Command Prompt window, try to ping the PowerCommand iWatch 100. Type “Ping xxx.xxx.xxx.xxx” as shown in Figure A-3. If you are successful, a reply will be returned indicating the turn-around time of the request and reply.

Remember that the default address of the PowerCommand iWatch 100 is 192.168.1.222. If you have loaded a CPG image, or changed the IP address per the customer’s requirements, you will have to ping the appropriate address. If the PowerCommand iWatch 100 is not found, the message “Request timed out” is displayed (see Figure A-4).

If the ping failed, make sure that your computer’s IP settings are compatible with the PowerCommand iWatch 100 and that the PowerCommand iWatch 100 is powered. Check to see that the PowerCommand iWatch 100 has a link light illuminated, which indicates a good Ethernet patch cable connection. Verify the i.LON 100’s IP address using HyperTerminal.

If you successfully ping your PowerCommand iWatch 100, re-attempt to open its internal or custom web pages using Internet Explorer 6.0 or higher.
FIGURE A-2. ENTERING THE IPCONFIG COMMAND

FIGURE A-3. PINGING THE POWERCOMMAND iWATCH 100

FIGURE A-4. PING FAILURE MESSAGE
SETTING A STATIC ADDRESS ON YOUR COMPUTER

To be able to dynamically change your IP address or set a static address on your computer, the computer must be connected to a live Ethernet port. You can verify this by looking at the Ethernet jack on the back of your computer. With the patch cable connected to a live Ethernet port, there should be an LED illuminated at the jack, either green or amber.

1. Open up the **Start → My Network Places** (see Figure A-5).

2. From the My Network Places window, select **View Network Connections** from the Network Tasks window on the left side of the screen (see Figure A-6).
3. From the Network Connections page, right click on your Local Area Network connection, and select Properties (see Figure A-7). The screen shown in Figure A-8 is displayed.
CAUTION: The following steps will affect your connection to your LAN. You must restore your original settings to get back on your LAN after you are done with the PowerCommand iWatch 100.

NOTE: For Cummins Employees using Power-Swept machines, the following steps will require Admin rights on the computer in use.

4. From the Local Area Connection Properties window, scroll down and select “Internet Protocol (TCP/IP),” and click on Properties. The window in Figure A-9 is displayed.

5. Select “Use the following IP address” and enter the information shown in Figure A-10.

6. Select OK when finished. Then select Close in the Local Area Connection Properties window. This will apply your changes.

NOTE: If you are asked to reboot your computer, your computer is not currently connected to a live Ethernet jack. You may either reboot, or connect your computer to a live Ethernet jack and repeat this process.

7. Using the Command window, try to ping the PowerCommand iWatch 100 again. It should work now.

8. If this doesn’t work, refer to the procedure in the Console Connection portion of Section 4 and use the Show command to confirm the address and subnet mask of your PowerCommand iWatch 100.

9. Then adjust the appropriate settings above to communicate.

NOTE: Your subnet mask must match that of the PowerCommand iWatch 100 for communication.

10. Remember to restore your settings in the Local Area Connection Properties when you are done to obtain an IP address automatically.